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Chapter 1
Web Portal Help Overview 

The PressOne Web Portal is web-browser-based application that allows you to 
manage your calls from your PC through an easy-to-use web browser interface. If 
you are using the Web Portal on a PC that is connected to the PressOne network, you
can use point-and-click capabilities to control calls as well as manage calls.

This section provides general information about the Web Portal operations, 
including:

• Web Portal login
• Using Web Portal with your phone
• Web Portal Tab descriptions
• How to page through web portal directories
• Optimum web browser settings

Web Portal Login
The Web Portal allows you to control your telephone from a PC that is on the same Pr
 network as your telephone. 

You can log into the PressOne Web Portal by using any Web browser and entering the
IP address of the PressOne Call Agent Server as the web address (URL). You wi
then see the Web Portal login page. 

You must enter your phone number and then enter the password for your phone.

NOTE: You can only log into Web Portal once on a particular machine on the 
same phone network using the same type of browser. For example, if you log 
in to Web Portal using Internet Explorer, then you try to bring up another IE 
browser and log in as a different number on the same VOISS network, the 
first Web Portal browser will revert back to its login page. Web Portal 
recognizes the new session and logs you out. However, if you bring up IE and 
log in, you can then bring up Netscape and log in with a different number. 

Click to Call - This checkbox is selected by default, which allows you to dial any 
phone numbers that you see listed in the Web Portal by just clicking on them. You 
can disable this capability in the event you are not physically near your PressOne 
phone to prevent dialing a number and not being able to pick up the handset.
VOISS Web Portal User’s Guide Web Portal Help Overview 1
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Using Web Portal in Conjunction with Your Phone

-

Using Web Portal in Conjunction with Your Phone
You can control your telephone using the Web Portal on a PC that is connected to 
the same PressOne system network as your telephone. 

The Web Portal does not provide a method for you to conduct conversations using 
a microphone or other audio device connected to your PC. You must be near the 
phone when placing a call from the Web Portal because it will activate a line on your 
telephone. If the phone is equipped with a speakerphone, it will be activated if you 
do not have a headset attached or pick up handset.

Web Portal Tabs
The tools available from the Web Portal menu include:

Directory

Provides access to the Corporate Directory, listing all your company's exten-
sion numbers, as well as a Personal Directory where you can add your 
favorite phone numbers.

Voice Mail

Allows you to play, forward, save or delete voice mail messages or return the 
callers call from the Inbox or Saved tabs. You can set up voice mail Distribu-
tion Groups and set up paging so that you are notified when you receive 
messages. On this screen you can also change your voice mail password.

Conferencing

Provides the ability to schedule Meet-Me Conference calls or find an avail-
able time for a conference call in the PressOne system, if allowed by the sys-
tem administrator. The Find feature allows any user, who may have 
forgotten the information for a Meet-Me Conference, to search for informa-
tion about the conference.

Call Management

Allows you to view and manage a log of all calls arriving at your telephone, 
screen calls by setting up call handling rules based on incoming telephone 
numbers, manage the forwarding of calls from your phone and control calls 
from the Web Portal.

Options

Provides the ability to change your telephone/Web Portal password, reas-
sign the phone number to a different phone, set up a remote phone that acts 
as your PressOne phone, integrate TAPI-based applications with the Web Por
tal, and set your personal profile for Web Portal.
2 Web Portal Help Overview VOISS Web Portal User’s Guide
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Paging through Web Portal Lists
You can page through a list in Web Portal using the controls at the bottom right side 
of the screen. 

The links have the following functionality:

• First – Takes you to the first page of the directory listing.
• Previous – Takes you to the page preceding the current page.
• Page – Takes you to the page selected by typing in a number.

Example: You might remember that John Public was on Page 13 the last 
time you looked him up and you may want to start there this time.

• Next – Takes you to the page following the current page.
• Last – Takes you to the last page of the listing.

Web Browser Settings
For best results with the Web Portal, you must set Internet Explorer or Netscape 
Navigator to allow Java applets.

NOTE: If using Internet Explorer, it is highly recommended that you upgrade 
to IE Version 6.0 or greater. For Internet Explorer versions before 5.5, you 
must set your pages to refresh every time to avoid using cached pages.

Internet Explorer
1. Select Tools.

2. Select Internet Options.

3. Click the Security tab and Custom Level button.

4. Makes sure that the Reset Custom Settings box says Medium. If not, select 
Medium from the drop down list and click Reset.

5. Click OK to return to the Internet Options dialog box.

6. Click OK again to close the Internet Options dialog box

Netscape Navigator
1. Select Edit.
2. Select Preferences.
VOISS Web Portal User’s Guide Web Portal Help Overview 3
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Web Browser Settings
3. Click on Advanced and enable JavaScript by making sure that the following 
fields are checked:

• Automatically load images
• Enable JavaScript
• Enable JavaScript for Mail and News
• Enable style sheets (Navigator 4.7 only)

4. Click OK.

Disabling Reuse of the Web Portal Active Window
You may also want to set your Internet Explorer browser so that it will not use the 
active Web Portal browser window when you click on shortcuts in other web sites. 
To do this, follow these steps:

1. On the Internet Explorer window, select the Tools menu.

2. Scroll down and click Internet Options.

3. Select the Advanced tab.

4. Under the “Browsing” options, uncheck the Reuse windows for launching 
shortcuts feature.
4 Web Portal Help Overview VOISS Web Portal User’s Guide
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Chapter 2
Using the Web Portal Call Control

The Web Portal Call Control window provides information about the line on your 
phone and calls in progress as well as providing basic call control functionality.

Call Control Window Functionality
• Making a call
• Transferring a call
• Hanging up a call
• Putting a call on Hold
• Parking a call
• Picking up a parked call
• Picking up a Multi-line parked call
• Using Do Not Disturb
• Using Speed Dials

Call Control Window Description
• Line Information - This line of text displays the 10-digit number line 

currently is use under the time and date. It also has the Help link.
• Call Progress Display - When making or handling a call, this display 

shows progress messages related to the call.
• Dial Keypad - A standard telephone dial that can be used for dialing 

telephone number by clicking on the keypad buttons
• Call Control Buttons - These buttons allow you to perform call control 

functions from the Web Portal including hanging up a call (Release), 
placing a call on Hold or Park or sending the call to another user 
(Transfer). You can also activate and deactivate the Do Not Disturb (Dnd) 
feature. Also provided is a text box that you can use for typing in 
telephone numbers for transfers.

• Speed Dials List - If you have speed dial numbers on your telephone, they 
will appear in the Speed Dials area and can by used by clicking on them. 
VOISS Web Portal User’s Guide Using the Web Portal Call Control 5
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Making a Call
Making a Call
Calls can be made from Web Portal Call Control dialog by typing them in the field 
next to the Dial button. The phone should be nearby, however, since it will activate 
the speakerphone feature of the phone. 

External Call
1. Enter the phone number for the outside line you wish to call.

NOTE: The outside access digit (such as 9) is NOT required to dial externally.

2. Click Dial.

The speakerphone is turned on, an outside line is automatically selected, and 
the call is connected.

3. Conduct the call using the speakerphone (if available), us a headset, or pick 
up the handset to continue the call.

Internal Call
1. Enter the desired extension (e.g., 1105).

The speakerphone is turned on, an internal line is automatically selected, and 
the call is connected

2. Conduct the call using the speakerphone (if available), use a headset, or pick 
up the handset to continue the call.

Authorization Code Call
If you are required to enter an authorization code for a call, follow these steps:

1. Enter pound (#) then the digits for the authorization code (obtained from your 
system administrator).

2. Click Dial.

The speakerphone is turned on and a line is automatically selected. You will 
hear dial tone if you entered the correct code.

3. Enter the digits for the number you want to call.

4. Click Dial to dial the number and connect with your party.

Transferring a Call
1. Click in the blank text window next to the Transfer button.

2. On your PC keyboard, type in the number to transfer the call to.
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3. Tell the caller you are going to transfer them and click Transfer.

4. The call is transferred and your line is released and ready to make additional 
calls.

NOTE: If this feature is not available in Web Portal, ensure that a button on 
your phone has this feature assigned.

Releasing a Call
To hang up, click Release on the Call Control dialog. 

To access the Call Control dialog, click the Call Control link in the upper right 
corner of the screen.

NOTE: If this feature is not available in Web Portal, ensure that a button on 
your phone has this feature assigned.

Holding a Call
On the Call Control dialog, the Hold button allows you to place a call on hold and 
retrieve the call from hold. Since the Web Portal supports only a single line 
appearance, no other action should be taken through the Web Portal when a call 
is controlled by the Web Portal. Use the buttons on your physical telephone if you 
need to make additional calls or perform other actions while the call is on hold.

To put a call on Hold:

1. Tell the caller you are putting them on hold.

2. Click Hold.

• A message that the call is on hold is displayed in the lower left hand 
corner of the Call Control Window and notification that hold is active may 
be displayed on your phone to remind you about the held call.

• Depending on your system configuration, the party may hear music, a 
recorded announcement, or silence while holding.

3. To resume the conversation, click Hold and begin speaking.

NOTE: After the party is on hold for one minute, the system rings the 
associated line to remind you that the party is holding. 

NOTE: If this feature is not available in Web Portal, ensure that a button on 
your phone has this feature assigned.
VOISS Web Portal User’s Guide Using the Web Portal Call Control 7
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Parking a Call
Parking a Call
Parking a call is similar to placing a call on hold, except that when a call is parked, 
you can pick-up the parked call from anywhere in the system and the line is free 
again. 

To park a call:

1. During the call, tell the caller that you are putting them on hold.

2. Click the Park button.

3. Hang up.

• The telephone provides a Park reminder and the associated line is now 
free to make or receive other calls. After the party is parked for 1 minute, 
the system rings the associated line to remind you that the party is still 
parked.

• To retrieve the parked call using the Web Portal, click the Park button.

NOTE: If this feature is not available in Web Portal, ensure that a button on 
your phone has this feature assigned.

Picking up a Parked Call
If your system is configured to with a Park Line (see Parking a Call), and a call has 
been parked, then you can pick up the call using the Pickup Park button on the 
Call Control window. 

NOTE: This feature may not be available if your PressOne system has been 
configured to support Multi-Line Call Park. If the Pickup Park button does not 
work, then the call was parked using Multi-line Call Park. You can enter the 
extension where the call is parked and click the Call Pickup button.

1. Click on Call Control in the upper right area of the display to bring up the 
dialog.

2. Click on the Pickup Park button to pick up the call.

Call Pickup for Multi-line Call Park
Your PressOne system can be configured to allow Multi-line Call Park. This means 
that when a user parks a call, an audio message tells the user an extension where 
the call is parked. To pick up the parked call, a user enters the extension specified 
in the message.

On Web Portal, the Call Pickup button on the Call Control dialog allows you to 
enter the parked call extension and pick up the call. This button will not operate, 
however, if Multi-line Call Park is not enabled for your system. In that case, try the 
Pickup Park button.
8 Using the Web Portal Call Control VOISS Web Portal User’s Guide
621-000000096



Adding Caller to a Conference Call using Call Control
If you are currently in a conference call, you can add another caller to the 
conference call from the Call Control dialog. Your system must be configured to 
allow Ad Hoc Conferencing and the ad hoc conference limit cannot be exceeded. 
The default limit is 3 callers that can be added ad hoc to a conference call, unless 
your system administrator has changed the limit.

To add a caller to a conference:

1. While in an active conference call, click on the Call Control link in the upper 
right area of the Web Portal display.

2. Enter the number of the person you want to add to the call in the field next to 
the Conference button, then click the button.

The caller will be added to the conference.

NOTE: If this feature is not available in Web Portal, ensure that a button on 
your phone has this feature assigned.

Using Do Not Disturb
Do Not Disturb instantly routes all your incoming calls to another destination (your 
voice mailbox, the main operator, your secretary, a co-worker), but still lets you 
make calls and use other telephone features. (You can record a special voice mail 
greeting for callers to hear if your calls go to voice mail when you activate the Do 
Not Disturb feature.) The Do Not Disturb destination is set by your system 
administrator.

To override this feature for specific callers use the Urgent Call setting in the Call 
Screening feature.

To Activate Do Not Disturb
1. Click DND.

2. "Do Not Disturb is on" is displayed at the bottom of the Call Control window 
until another control is used or the window is closed.

• A message that DND is active may be displayed on your phone to remind 
you that the feature is active.

• A lamp next to a Do Not Disturb button on your telephone may blink to 
confirm that the feature is active.

To Cancel Do Not Disturb
1. Click DND.
VOISS Web Portal User’s Guide Using the Web Portal Call Control 9
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Using the Speed Dial List
2. "Do Not Disturb is off" is displayed at the bottom of the Call Control window 
until another control is used or the window is closed.

• A message that DND is active may be displayed on your phone to remind 
you that the feature is active.

• A lamp next to a Do Not Disturb button on your telephone may blink to 
confirm that the feature is active.

NOTE: If this feature is not working, ensure that a button on your phone has 
this feature assigned.

Using the Speed Dial List
The Speed Dials list in the Call Control Window lists the numbers that are 
programmed into the speed dial buttons on your telephone. The numbers in this list 
can be used when dialing, transferring a call, or conferencing in.

To use the Speed Dial list:

1. If desired, pick up the handset on your telephone. (Otherwise, the 
speakerphone will be activated).

2. Click the desired speed dial number in the list. 

The number is displayed to the right in three of the fields.

3. Do one of the following:

• Dial to dial the number
• Transfer to transfer a call to the number
• Conference to conference that party in to a currently active conference 

call.
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Chapter 3
Using the Web Portal for Call 
Management

The Web Portal provides several tools for managing your calls. They include:

• Call Log - Provides a record of calls made and received from your 
telephone number including whether the call was answered or not.

• Find-Me Forwarding - Allows you to configure your VOISS phone so that 
incoming calls are routed to other phone numbers if you don't answer 
your VOISS phone.

• Call Treatment - This tab provides various methods of screening 
incoming calls and routing or forwarding your calls.

About the Call Log
The Call Log is accessed by clicking on the Logs tab under the Call Management 
tab. This screen provides a record of all of the incoming, outgoing and missed calls 
to the phone. In addition, the Call Log allows you to do the following:

• Return calls from entries
• Set up Call Screening
• Sort entries

The log is sorted by Date/Time by default, with the latest entries listed first. The 
following describes the fields on this display.

Direction - Indicates whether the call was Incoming, Outgoing, or Missed. If the 
call was Missed, click the Voice Mail tab to see if the caller left a message.

Phone Number - If the caller had the caller ID feature enabled, then the phone 
number will be displayed. You can click on the phone number to return the call. 

NOTE:You must be near the phone when placing a call from the Web Portal 
because it will activate a line on the telephone that the number is assigned to.

Name - displays the Caller Name if it is reported by Caller ID. Otherwise, it displays 
"Private."

Date/Time - The date and time that the call began is displayed in the format: MM/
DD/Year HH:MM:SS.
VOISS Web Portal User’s Guide Using the Web Portal for Call Management 11
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About the Call Log
Length - The duration of the call is displayed in the format MM:SS.

Functions - Provides a Call Screening icon ( ) that when clicked, takes you to 
the Add Call Screening display where you can set up call screening functions for 
the call log entry. 

Select - Provides checkboxes for selecting entries to be deleted. You can check 
one or more of these checkboxes, then click the Delete button at the bottom of the 
screen to remove entries from the Call Log.

Call Screening from the Call Log
From the Logs tab under Call Management, you can set up call screening actions 
(such as send to voice mail or forward to another number) for the numbers listed in 
the Call Log. 

1. Find the entry you want to screen.

2. Click the Call Screening button ( ) next to that entry.

The Name and Incoming Number fields will be automatically filled in.

3. Refer to Call Screening for a detailed description of the Time of Day Actions 
and Default Action.

4. Click Save for the call screening settings to be recorded or Cancel to exit the 
screen.

Sorting the Call Log
The list can be sorted in ascending (top-down.) order or descending order based 
on any of the columns that has an underlined title. Click a column heading to sort 
the list based on that column.

The column that is currently being used for sorting is marked with an up- or down-
arrow. If the arrow is pointing down, then the list is sorted in ascending order (top-
down, first to last, A-Z, etc.). If the arrow is pointing up, then the list is sorted in 
descending order based on that column.

If the information displayed does not seem to be up-to-date, see Web Browser 
Settings.

Returning Calls from the Call Log
1. Locate the entry/message to which you want to return a call.

2. Click on the extension or telephone number of that entry/message in the 
Phone Number column.

3. The Call Control window appears and displays call progress messages while 
you hear ringing through the speaker in your phone.

4. To end the call you can click on:
12 Using the Web Portal for Call Management VOISS Web Portal User’s Guide
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Creating a Find-Me Phone Number List
• Release to hang up
• Transfer to transfer the call
• Hold to put the call on hold
• Park to park the call

You must have the features listed in Step 4 assigned to your phone for those 
features to be available from the Web Portal.

Find-Me Forwarding
The Find-Me feature lets you specify a list of phone numbers where a call will be 
forwarded if you do not answer your phone. This allows a caller to reach you at any 
one of your designated phone numbers. For example, if you will be away from the 
office, you can set Call Management options to forward calls to your mobile phone 
number, then your home office phone number, and finally your home number. If you 
do not pick up at the final destination, the call will be transferred to voicemail. 

The following operations allow you to configure Find-Me phone numbers and 
choose the order in which the call is forwarded.

• Create a Find-Me phone numbers list
• Configure Sequential vs. Ring All and Show Caller ID
• Add more numbers to a Find-Me list
• Change the order of the numbers in a Find-Me list

Creating a Find-Me Phone Number List
The Find-Me feature is enabled when one or more Find-Me phone lists are created. 

1. Under the Call Management tab, click the Find-Me tab.

2. Click Add to create a new list.

3. On the Numbers page, click Add to add a phone number to the list.

4. Enter a name and phone number where the phone should be forwarded if you 
do not answer.

5. If desired, use the pull-down lists to set the following

• No Answer Timeout – the number of seconds the system will attempt to 
connect to this phone number. 

• Menu Timeout – the number of seconds the user has to respond to menu 
options. 

6. Click the Save button to create a new Find-Me List with one phone number. 

Once it has been initially created, you can add more phone numbers to the list or 
you can modify the forwarding method used (sequential or ring all). You can also 
specify whether or not to display the caller ID for the incoming call.
VOISS Web Portal User’s Guide Using the Web Portal for Call Management 13
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Find-Me Forwarding
Configuring Sequential vs. Ring All and Show Caller ID
The Find-Me feature allows a call to be forwarded two ways:

sequential – the call will be forwarded sequentially to each phone number in the 
Find-Me list. If there is no answer at the first number, the call is transferred to the 
next number in the Find-Me list until the final phone number is reached. 

ring all (parallel) – All of the phones in the list will ring simultaneously. When the 
call is picked up at any of the numbers, the call is completed and the other 
destinations will no longer ring.

To configure the Find-Me Options:

1. After creating a list and adding a number, you should be on the Numbers 
page. If not, click on Call Management, and click the edit button ( )under 
the Functions column next to the list you want to configure.

2. On the Numbers page, select the Options button.

3. Next to Find-Me Strategy, select either Sequential or Ring All.
4. If desired, uncheck the Show Caller ID box to prevent showing the incoming 

call's caller ID on the destination phone. This box is checked by default.

5. Click Save to store the changes. 

Adding More Numbers to a Find-Me List
1. Click on Call Management and the Find-Me tab.

2. Click the edit button ( ) under the Functions column next to the list you 
want to configure.

3. On the Numbers page, select the Add button.

4. Enter the name and phone number of another call destination. If desired, 
modify the timeout options.

5. Click Save to store the changes. 

Re-ordering the Numbers in a Find-Me List
After adding numbers to a Find-Me list, you may want to change the order in which 
the numbers are called. The numbers in the Find-Me list will be tried in ascending 
order, from first to last.

1. Click on Call Management and the Find-Me tab.

2. Click the edit button ( ) under the Functions column next to the list you 
want to configure.

3. On the Numbers page, click the up arrow ( ) to move a number up in the 
list. Click the down arrow ( ) to move a number down in the list. 
14 Using the Web Portal for Call Management VOISS Web Portal User’s Guide
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Re-ordering the Numbers in a Find-Me List
Call Treatment
The Call Treatment tab under Call Management allows you to apply call handling 
rules for either your phone or for each specific caller.

There are two ways to look at Call Treatment:

• Forwarding – this is a way of configuring your phone so that any 
incoming call is routed to a particular destination.

• Call Screening – this is a way of controlling where specific incoming calls 
will be routed. 

Call Treatment Summary
The Call Treatment Summary page lists of all forwarding and call screening rules 
that are in effect. There are two different types of entries in the list. The first entry 
shows Default Forwarding for your phone and you can modify this entry is to click 
on the Edit button ( ) under the Function column. The other entries indicate call 
screening actions that have been applied to particular incoming numbers. 

The following describes the fields on the Summary page:

• Name – The Default Forwarding entry shows whether or not your phone 
has forwarding rules applied. The other entries show names of callers 
that have call screening actions applied. 

• Incoming Number – The number shown for the Default Forwarding entry 
will always be All Unscreened. For the other call screening entries, this 
column lists the phone number to be screened.

• Action – This column lists all of the actions that have been configured for 
this entry. If it shows Disabled, then there are no actions applied. 

• Company – Indicates the Company name for this caller, if any.
• Phone Numbers – Lists all of the phone numbers for this caller that have 

call screening applied.
• Function – Click the Edit button ( ) in this column to apply call 

screening options.
• Select – Click this checkbox for all entries that you want to delete, then 

click the Delete button at the bottom of the screen.

Call Treatment Operations
There are several functions that can be performed on from the Call Treatment 
page. Click on the following links for more information on these operations.

• Forwarding (  on the Default Forwarding entry)
• Selective Forwarding (Options)
• Call Screening
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Call Treatment
Call Forwarding
You can forward your phone by clicking on Call Management, then Call 
Treatment. Forwarding is disabled when the Action column on the summary 
shows Disabled next to a red dot. When forwarding is disabled, all unanswered 
calls will be forwarded to your voice mail box. This setting is overridden by any Call 
Screening actions that may be set. 

There are two levels of forwarding: Basic and Advanced.

• For Basic forwarding features, click the Edit button ( ) next to the 
Default Forwarding entry in the summary list.

• For Advanced forwarding features, go to the Basic page, and click the 
Advanced button.

Basic Default Forwarding

This page allows you to enter a number where all incoming calls to your phone will 
be forwarded. By selecting the Default Action pull down list, you can choose one 
of the following:

• Disabled
• Find-Me (if there is at least one Find-Me list defined)
• Forward to Number
• Forward When Busy/No Answer

When you select one of the actions, then fields will appear in which you can enter 
the forwarding destination number or numbers. Phone numbers can be entered 
using dashes, periods, spaces and other special characters.

Click Save to save the settings or Cancel to return to the previous display without 
saving.

Advanced Default Forwarding

When you click on Advanced at the bottom of the Basic Default Forwarding 
screen, a new screen is presented that has several forwarding and call screening 
Actions that can be applied to your phone. When you select an action, the Time of 
Day fields will appear that allow you to set specific times and days for the action. 
See Call Screening for more detailed information.

Call Screening
The Call Screening function provides a flexible method of screening and forwarding 
calls anytime or at specific times and on certain days of the week. 

Call Screening is set up via the "Call Screening" display. This display can be 
accessed in several ways:
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Call Screening
• By clicking on Call Management > Call Treatment > Add Call 
Screening

• From a Directory, by clicking on the Options button ( ) 
• From the Call Log by selecting Call Management > Logs and clicking on 

the Call Screening button ( ) next to the desired entry.
• From Voice Mail, by clicking Voice Mail, and the Call Screening button 

( ) next to the desired entry.

When the Call Screening display first comes up, it will look something like this. If 
you access it from a Directory, the Call Log or Voice Mail, then the name and 
number fields will be filled in.

How Time of Day Actions Work

Each Time of Day Action has associated fields that are hidden until you select an 
action from the pull-down menu. When you select an action, you must specify 
some time frame for the action, and if the selection involves forwarding, you must 
enter a forward destination number. The following picture shows the fields that are 
displayed after a Time of Day Action is selected:
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Call Treatment
The pull-down menus provide several types of forwarding and call screening 
options. The following is a description of these choices:

• Disabled – This indicates the Time of Day action is not in effect. 
• Call Block – This selection will block calls from this phone number. The 

caller will hear a recorded message that you are not accepting calls.
• Forward to Number – Calls from this number will be forwarded to the 

phone number that you specify in the Forward to field. The originally 
called number is bypassed and does not ring.

• Forward to VoiceMail – The call goes directly to voice mail without ringing 
your phone.
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Call Screening
• Selective Forwarding – This caller will be forwarded to a specified 
number. NOTE: This option will only be displayed if a selective forwarding 
number has already been defined. See Selective Forwarding for more 
information about this feature.

• Priority Call – This will mark this number as a priority call and it will have 
a priority ring tone. The priority ring tone you will hear depends on the 
type of phone you have.

• Urgent Call – The call rings through to your telephone regardless of 
whether the Do Not Disturb feature is invoked. If you do not answer the 
phone, it is forwarded to voice mail and is tagged as an urgent message. 
If you want to be paged when you receive an urgent message, make sure 
that you have checked both the "Paging" and "Urgent" settings in Pager 
Notifications under Voice Mail.

• Virtual Ring – The caller always hears a ring. To the caller it appears as if 
their call is not being answered. Actually the call does not ring at your 
phone, nor does it go to voice mail, it is simply routed to a virtual phone.

• Find-Me – This option will only be displayed if at least one Find-Me list has 
been created. The Find-Me feature will forward the incoming call to a list 
of phone numbers specified by the user.

• Forward when Busy – If your phone is busy when this call comes in, the 
call will be forwarded to the number specified in the Forward to field. 

• Forward when No Answer – If your miss the call, it will be forwarded to 
the number specified in the Forward to field.

Specifying a Time of Day

To specify a time of day for a particular action, select the action and then choose 
the appropriate time and date elements. If you want the action to occur all day on 
Monday, click the All Day checkbox, and the Monday checkbox. If you wanted it to 
occur every Monday, check the Everyday checkbox also. You can specify a time 
frame by selecting the Start Time and End Time (using a 24-hour clock).

The Time of Day Actions are implemented in order from top to bottom. If Time of 
Day Action time frames overlap, each subsequent one takes precedence over the 
previous one. The Default Action is the ultimate action that is implemented for the 
caller.

Example of overlapping Time of Day Actions: 

• ToD Action 1 forwards to x1234 from 11:30 to 1:00 pm. 
• ToD Action 2 forwards no answer to x2345 from 9:00am to 12:00pm

Result: 

• An unanswered call at 10:00am will be forwarded to x2345.
• Any call at 11:15 will be forwarded to x1234 without ringing the original 

phone.
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Call Treatment
• An unanswered call that is before 9:00am or after 1:00 pm will result in 
the standard action (go to voice mail).

Adding a New Call Screening Entry

You can add one or more call screening entries from the Call Management > Call 
Treatment page as well as from the Corporate and Personal directories and the 
Call Log.

1. On the Call Treatment page, click Add Call Screening.

2. Enter a name for this entry in the Name field.

3. Enter the caller's telephone number (as you see it displayed in the Call Log 
or on your phone display, if you have one) in the Incoming Number field.

NOTE: It must match exactly since this is the telephone number the system 
uses to look up the action to take.

4. Click on the down arrow in the Time of Day Action pull-down list and select 
the action to be taken by clicking on it.

5. If the action is a forwarding action, do one of the following:

• For Forward to Number, enter the number of the telephone the call should 
be forwarded to in the Fwd field.

• For Selective Forwarding, enter the number all Selective Forwarding calls 
will be forwarded to in the Fwd field. (See Selective Forwarding for more 
information on this option.)

6. If the action is to send to voice mail, you must have a voice mail box to which 
to send callers.

7. Click Add to save the current entry and add more entries or click Save to save 
the information and be able to select another function.

Deleting an Entry

You can delete one or more entries.

1. Click the checkbox under the Select column for each entry you want to delete.

2. Click Delete.

Editing an Entry

You can edit one or more entries directly on the Call Management > Call 
Treatment page by changing the information in the fields and clicking the Save 
button.

3. Locate the entry you want to edit.

4. Click the Edit button ( ) next to the entry you want to change.
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Selective Forwarding
• If you selected the Default Forwarding entry, see Forwarding for more 
information.

• If you selected one of the call screening entries, see Call Screening for 
more information. 

5. Replace or correct existing information or select a new action.

6. Repeat for additional entries until all necessary changes have been made.

7. Click Save.

Selective Forwarding
The term "Selective Forwarding" means that all incoming calls that are set to be 
selectively forwarded are forwarded to one particular phone number.

The Selective Forwarding screen allows you to input the destination number 
where these calls will be sent. 

To set up Selective Forwarding:

1. Under the Call Management tab, click the Call Treatment tab, then click the 
Selective Forwarding Number button.

2. In the Selective Forwarding Number field, enter the destination phone 
number where incoming calls will be sent when the Selective Forwarding 
feature is set for those callers. I

To set Selective Forwarding for an incoming call:

1. Click on Call Management tab, then the Call Treatment tab.

2. Click on the Add button.

3. Enter Name and Incoming Number of incoming call. 

NOTE: You can do this from the Directory page also.

4. Select Default Action pull down and Selective Forwarding.
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Chapter 4
Using the Web Portal Directories

The PressOne Web Portal provides two directories for your use - Corporate and 
Personal. The corporate directory provides a listing for everyone in your company 
while the personal directory is where you keep all your personally important 
telephone numbers.

Sorting the Directory

Both directories allow you to sort using the column headings. In the corpo-
rate directory these are last name, first name, title and extension while in the 
personal directory these are last name, first name and company. The col-
umn used for sorting is marked with a star so you don't have to remember 
which one you used. The order of the columns is not changed when they are 
sorted.

Screening Calls

Both directories also allow you to screen calls - apply call handling rules for 
a specific caller - with a few simple clicks of your mouse.

Navigating the Directory

The Corporate Directory provides both a paging and search tool for finding 
company employees. The Personal Directory requires you to scroll through 
entries. When combined with the sort functions, you should be able to easily 
find the desired information.

If the information displayed does not seem to be up-to-date, see Web Browser 
Settings.

Using the Web Portal Corporate Directory
The Web Portal Corporate Directory provides a listing of all the employees within 
your company and allows you to do any of the following:

• Call from the directory
• Leave voice mail from the directory
• Set up Call Screening
• Add a person to a conference call
• Sort the directory
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Using the Web Portal Corporate Directory

 

 

• Search the directory

The file containing the Corporate Directory stays in the PressOne system so that it is
available to you from any PC with Internet access.

If the information displayed does not seem to be up-to-date, see Web Browser 
Settings.

Calling From the Corporate Directory
1. Locate the entry for the person you want to call (See Searching the Directory).

2. Your telephone should be nearby. For details, see Using the Web Portal with 
Your Phone.

3. Click on the extension or telephone number of that person.

HINT: When dialing outside numbers, it is not necessary to dial the outside 
access digit.

4. The Call Control window appears and displays call progress messages while 
you hear ringing through the speaker in your phone.

5. To end the call you can click on:

• Release to hang up
• Transfer to transfer the call
• Hold to put the call on hold
• Park to park the call

NOTE: You must have the features listed in Step 5 assigned to your phone 
for those features to be available from the Web Portal.

Leaving Voice Mail from the Directory
Since the Corporate Directory is created by the PressOne system, it knows the voice
mail address for each user (if the user has voice mail) and can connect you directly 
to the user's voice mail mailbox to leave a message. This eliminates having to call 
someone and wait for their greeting to play before leaving them a message.

To send voice mail directly to a user's mailbox:

1. Locate the person in the directory to whom you wish to send voice mail.

2. Click the Voice Mail button ( ) next to the desired entry listing.

3. Record your message.

4. Hang up or select additional options from the menu.
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Screening Calls from the Directory
Screening Calls from the Directory
You can set up Call Screening actions (such as send to voice mail or forward to 
another number) for the callers listed in your directory. 

1. Find the caller you want to set up a call screen action for.

2. Click the Options button ( ) next to the directory entry that you want to 
screen.

3. Click the phone number for the entry that you wish to screen (if there is more 
than one number).

4. Click Add to Call Screening to add a call screen action, or Cancel to exit 
back to the previous screen.

5. On the Call Screening display, select the desired Default Action. If desired, 
select one or more Time of Day Action for the number.

NOTE: The actions will be implemented from the top down. That is, Time of 
Day Action 1 will be implemented first, then Time of Day Action 2, etc. After 
enacting each Time of Day Action (if any are enabled), then the Default 
Action is implemented.

6. Click Save to save the screening action for the selected number, or Cancel 
to exit.

Adding a Person to a Conference Call
You can add a person listed in either your Corporate or Personal directory to an 
ongoing Meet-Me Conference Call. When you click on the Meet-Me Conference 
button ( ) to the right of the directory entry, the Call Control dialog box will be 
presented showing that a call is being placed to connect the selected person to the 
conference call. 

NOTE: You must already be logged into the conference yourself before you 
can add a person from your directory to the call. 

If you click the Conference button when there is no active conference call, the "No 
Active Call" message will be displayed at the top of the Call Control dialog box.

Sorting Corporate Directory Entries
The list can be sorted in ascending (top-down.) order or descending order based 
on any of the columns that has an underlined title. Click a column heading to sort 
the list based on that column.

The column that is currently being used for sorting is marked with an up- or down-
arrow. If the arrow is pointing down, then the list is sorted in ascending order (top-
down, first to last, A-Z, etc.). If the arrow is pointing up, then the list is sorted in 
descending order based on that column.
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Using the Web Portal Personal Directory
If the information displayed does not seem to be up-to-date, see Web Browser 
Settings.

Searching the Directory
You can search the directory for a particular entry using the pull-down menu at the 
top right corner of the screen.

The search menu allows you to find entries in the directory by:

• Extension when a number to search for is entered
• First Name with the desired name entered
• Last Name with the desired name entered
• Title with a title entered

Select the search type, then enter the string to search for in the text field and click 
the Go button to search for the entry. When it is found, the page that the entry is on 
will be displayed.

Using the Web Portal Personal Directory
The Web Portal Personal Directory provides you with a place to keep all your 
personally important telephone numbers and allows you to do any of the following:

• Add entries to the directory
• Import entries from a saved Comma Separated Value (CSV) file
• Delete entries from the directory 
• Call from the directory (by clicking on the number)
• Send e-mail from the directory ( )
• Set up Call Screening ( ) 
• Add a person to a conference call ( )
• Sort the directory
• Search the directory
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Adding and Editing Directory Entries

 

Adding and Editing Directory Entries
You can add entries to the Personal Directory through the Web Portal. The file 
containing the information stays in the PressOne system so that it is available to you
from any PC with Internet access.

1. To add a new entry, click Add. To edit an entry, click on the Edit  icon to 
the left of the name. 

2. For adding or editing, enter the appropriate information in the fields.

3. Click Save to record the information in the Personal Directory. 

4. If you decide you do not wish to continue adding or editing, click Cancel.

Importing Directory Entries from a CSV File
You can import an existing contact list that you exported from Outlook or Excel as 
a comma separated value (CSV) file. 

Creating a CSV File

Outlook has an "Import and Export" feature under the File menu that allows you to 
export the Contacts list. A CSV file that has been exported by Outlook can be 
opened and edited in Excel. Also, a file can be created in Excel and then exported. 

NOTE: If your CSV file was created in Excel and contains a long international 
number starting with a zero, the default cell size in Excel will display this 
number in exponential format. When this information is exported from Excel 
into a CSV file, the leading zero is no longer on the number. When the data 
is imported into Web Portal, the number will not be correct because the 
leading zero was not in the file that was imported. 

For example: phone number 011-845-882-2999, when entered in Excel with the 
standard cell width, will be displayed as 1.18459E+11. Therefore, 11845911 will be 
the number that gets exported to a CSV file by Excel. 

To correct this problem, be sure to widen the columns in Excel so that the number 
is displayed correctly before you export it to a CSV file. This problem does not 
occur when exporting data from Outlook.

Checking the File Format

The CSV file that is being imported must be in a particular column order. Before 
attempting to import the file, open it in Excel and make sure the columns are in the 
following order:

• First Name
• Last Name
• Company
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Using the Web Portal Personal Directory
• Job Title
• Business Phone
• Business Fax
• Home Phone
• Mobile Phone
• Pager
• E-mail Address

Importing the File

To import a CSV file into Web Portal, do the following:

1. From the Directory menu, select Personal Directory.

2. Select the Import button at the bottom of the directory list.

3. On the Import page, if you want to import all new directory entries (none of 
the contacts in the CSV file already exist in your Personal Directory), then 
select the Append button.

NOTE: If you have contacts in the CSV file that have already been imported 
to the directory, and Append is selected, the import function will fail due to 
duplicate entries.

4. If you want to update your existing Personal Directory entries because you 
added new contacts to the CSV file, then select the Overwrite button.

5. Type in the entire path name of the file you wish to import. If you do not know 
the path name, click Browse to search for the file.

6. Click Upload File to import the file.

7. A window will be displayed listing the contents of the file. Click the Import 
button to import the file. If you do not want to import the file shown or you wish 
to select a different file, click the browser's Back button.

8. If you clicked Import, you should get a message saying "Directory 
successfully imported".

Calling From the Personal Directory
1. Locate the entry for the person you want to call (See Searching the Directory).

2. Your telephone should be nearby. For details, see Using the Web Portal with 
Your Phone.

3. Click on the extension or telephone number of that person.

HINT: When dialing outside numbers, it is not necessary to dial the outside 
access digit.

4. The Call Control window appears and displays call progress messages while 
you hear ringing through the speaker in your phone.
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Deleting Directory Entries
5. To end the call you can click on:

• Release to hang up
• Transfer to transfer the call
• Hold to put the call on hold
• Park to park the call

NOTE: You must have the features listed in Step 5 assigned to your phone 
for those features to be available from the Web Portal.

Deleting Directory Entries
When you are on the Personal Directory page, you can delete one or more entries. 
You may check multiple entries and delete them all at once.

1. Click Edit.

2. Click the checkbox in the Delete column for all the entries you wish to delete.

3. Click Delete to delete the all of the checked entries.

WARNING: The deletion takes effect immediately when you click Delete. 
There is no confirmation dialog asking if you really want to delete the entries 
and there is no undo.

Sending E-mail from the Directory
If an e-mail address is part of a directory listing, you can send e-mail from the Web 
Portal using the default mail program on your PC. You must be connected to the 
Internet to send the e-mail message.

To send e-mail to a person in the directory:

1. Locate the person in the directory.

2. Click on the e-mail button ( ).

3. If an email address has been specified in the directory entry, then the email 
will be addressed automatically. Otherwise, enter the email address for the 
person.

4. Enter your message and send it.

Screening Calls from the Directory
You can set up Call Screening actions (such as send to voice mail or forward to 
another number) for the callers listed in your directory. 

1. Find the caller you want to set up a call screen action for.

2. Click the Options button ( ) next to the directory entry that you want to 
screen.
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Using the Web Portal Personal Directory
3. Click the phone number for the entry that you wish to screen (if there is more 
than one number).

4. Click Add to Call Screening to add a call screen action, or Cancel to exit 
back to the previous screen.

5. On the Call Screening display, select the desired Default Action. If desired, 
select one or more Time of Day Action for the number.

NOTE: The actions will be implemented from the top down. That is, Time of 
Day Action 1 will be implemented first, then Time of Day Action 2, etc. After 
enacting each Time of Day Action (if any are enabled), then the Default 
Action is implemented.

6. Click Save to save the screening action for the selected number, or Cancel 
to exit.

Adding a Person to a Conference Call
You can add a person listed in either your Corporate or Personal directory to an 
ongoing Meet-Me Conference Call. When you click on the Meet-Me Conference 
button ( ) to the right of the directory entry, the Call Control dialog box will be 
presented showing that a call is being placed to connect the selected person to the 
conference call. 

NOTE: You must already be logged into the conference yourself before you 
can add a person from your directory to the call. 

If you click the Conference button when there is no active conference call, the "No 
Active Call" message will be displayed at the top of the Cal)l Control dialog box.

Sorting Personal Directory Entries
The list can be sorted in ascending (top-down.) order or descending order based 
on any of the columns that has an underlined title. Click a column heading to sort 
the list based on that column.

The column that is currently being used for sorting is marked with an up- or down-
arrow. If the arrow is pointing down, then the list is sorted in ascending order (top-
down, first to last, A-Z, etc.). If the arrow is pointing up, then the list is sorted in 
descending order based on that column.

If the information displayed does not seem to be up-to-date, see Web Browser 
Settings.
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Searching the Directory
Searching the Directory
You can search the directory for a particular entry using the pull-down menu at the 
top right corner of the screen.

The search menu allows you to find entries in the directory by:

• Extension when a number to search for is entered
• First Name with the desired name entered
• Last Name with the desired name entered
• Title with a title entered

Select the search type, then enter the string to search for in the text field and click 
the Go button to search for the entry. When it is found, the page that the entry is on 
will be displayed.
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Chapter 5
Using Web Portal Meet-Me Conferencing

The Meet-Me Conference feature provides a list of scheduled conferences that 
multiple callers can dial into and be connected. Anyone can participate in a Meet-
Me conference, but to schedule a Meet-Me Conference, your administrator must 
allow you access to the scheduling function. If you have not been granted 
scheduling permission, selecting the Conferences menu item will return a message 
that you are not authorized to schedule conferences.

From the Web Portal you can do the following:

• Schedule (Add) a Meet-Me Conference (with the proper authorization)
• Find a Meet-Me Conference
• Modify a Meet-Me Conference
• Delete a Meet-Me Conference
• Sort the conference listing

Scheduling a Meet-Me Conference
NOTE: The Conferencing tab will only be present in your instance of the Web 
Portal if your Virtual Network and phone line's Class of Service is configured 
to allow Meet-Me Conferencing.

You can create a new conference or find available conference times if the Meet-Me 
Conference system is heavily used and you want to be sure to get a time that is 
available with the number of ports for your callers.

To create a new conference:

1. Click on the Conferencing tab.

2. Click Add at the bottom of the list of conferences.

3. Enter a brief description of the topic of the conference in the Subject field.

This helps members of the conference find it in the future if they need to be 
reminded of the time or number to call to join the conference.

4. Set the date and time for the conference to start using the pull-down lists.

Fields are provided for month, day, year, hours and minutes. The time fields 
use a 24-hour clock.
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Finding Available Conference Times
5. Set the length of the conference using the Length pull-down list. 

NOTE: The minimum length of a conference is 15 minutes. If you select a 
lenght of time less than 15 minutes, an error message will be generated. The 
length of a conference can be extended in increments of 5 minutes.

6. Enter the expected Number of Participants.

7. Click Save to create the conference.

8. Click the Conferencing tab again to see the new conference listing.

• The Moderator ID is the password that allows you to access the 
conference settings through the conference setup telephone number.

• The Guest ID is the password that allows callers to access the conference 
through the conference join telephone number. You should provide the 
Guest ID and conference telephone number to those persons who are 
supposed to attend the conference.

Finding Available Conference Times
NOTE: The Conferencing tab will only be present in your instance of the Web 
Portal if your Virtual Network and phone line's Class of Service is configured 
to allow Meet-Me Conferencing.

1. Click on the Conferencing tab. 

2. Click Find at the end of the list of your conferences.

3. Set the dates and times for the search period using the pull-down lists next to 
Search starts and Search ends.

• Fields are provided for month, day, year, hours and minutes.
• Conference start times are available only in 15-minute increments 

beginning on the quarter hour.
• The time fields use a 24-hour clock.

4. Set the time of day during which your conference can be held using the pull-
down lists in the hours and minutes fields next to the Days start and Days end 
fields.

NOTE: The time fields use a 24-hour clock.

5. If weekends are available for conference calls and you will accept a weekend 
time (if available), make sure the Include Weekends checkbox is checked. 
(The default is not checked.)

6. Set the length of the conference using the pull-down list in the Duration field.

7. Enter the number of participants in the conference call in the Ports field.

8. Click Search.

9. A list of clickable possibilities will appear, if there are available possibilities 
that match your search.
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10. Click one of the possibilities to open a screen with all the fields filled in except 
Subject.

You can either enter a subject and be finished or adjust any of the fields and 
add a subject.

11. Click Save.

12. A screen appears confirming the conference has been scheduled and 
offering three choices:

• Click OK to create the conference.
• Click Modify to make a last minute change before creating the 

conference.

13. If you clicked OK and there were ports available at your time, you will see 
your conference listed in your conference listings.

• The Moderator ID is the password that allows you to access the 
conference settings through the MeetMe Setup telephone number.

• The Guest ID is the password that allows callers to access the conference 
through the MeetMe Join telephone number. You should provide the 
Guest ID and MeetMe Join telephone number to those persons who are 
supposed to attend the Meet-Me Conference.

14. If you clicked Modify, you will see a screen that shows the two IDs and allows 
you to change any of the conference parameters.

15. After making any changes, click Save and you are taken to the conference 
listings.

16. If you clicked Delete, you return to the conference listings.

Finding a Meet-Me Conference
NOTE: The Conferencing tab will only be present in your instance of the Web 
Portal if your Virtual Network and phone line's Class of Service is configured 
to allow Meet-Me Conferencing.

1. Click on the Conferencing tab.

2. Enter one or more of the following in the appropriate fields:

• Moderator Name
• Guest ID
• Date (in MM/DD/YYYY format)
• Subject

TIP: The more fields you can enter, the fewer conferences you will have to 
search through to find the correct one.

3. Click Search.
VOISS Web Portal User’s Guide Using Web Portal Meet-Me Conferencing 35
621-000000096



Modify or Delete a Conference
4. A list of matching conferences is returned and can be sorted.

NOTE: Searching for a Meet-Me Conference will not provide you with the 
Guest ID if you have forgotten it, but will allow you to search your notes or 
planner for the ID based on the moderator or date and time of the conference 
call. If you cannot find the Guest ID, you will have to call the moderator to get 
it from them.

Modify or Delete a Conference
NOTE: The Conferencing tab will only be present in your instance of the Web 
Portal if your Virtual Network and phone line's Class of Service is configured 
to allow Meet-Me Conferencing.

Modifying a conference
1. Click on the Conferencing tab.

2. Find the conference you want to modify.

3. Click on the Edit button ( ) to modify the conference parameters. 

4. Click Save.

Deleting a conference
To delete a conference, click the red button in the Delete column on the desired 
conference listing.

Sorting Conference Entries
The list can be sorted in ascending (top-down.) order or descending order based 
on any of the columns that has an underlined title. Click a column heading to sort 
the list based on that column.

The column that is currently being used for sorting is marked with an up- or down-
arrow. If the arrow is pointing down, then the list is sorted in ascending order (top-
down, first to last, A-Z, etc.). If the arrow is pointing up, then the list is sorted in 
descending order based on that column.

If the information displayed does not seem to be up-to-date, see Web Browser 
Settings.
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Chapter 6
Using the Web Portal to Manage Voice 
Mail

NOTE: The Voice Mail tab will not be available if you are using a SIP phone.

Web Portal offers access to and management of your voice mail using the following 
tools:

• Accessing your Voice Mail Inbox
• Managing Saved Voice Mail
• Paging Notification
• Managing Voice Mail Distribution Groups
• Changing the Voice Mail Password

Managing Your Inbox and Saved Voice Mail
Voice mail messages that have not been read, saved or deleted are stored in the 
Inbox. These may include new messages as well as previously listened to 
messages. Voice mail is not removed from the Inbox after you listen to them until 
they are saved or deleted. Click on the Voice Mail tab, then the Inbox tab to see 
these messages.

Clicking on the Saved tab will display all voice mail messages that you have 
previously saved.

From the Web Portal you can do any of the following with voice mail messages:

• Play messages
• Forward messages
• Return a call to the caller
• Save or delete messages
• Sort messages

If the information displayed does not seem to be up-to-date, see Web Browser 
Settings.
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Managing Your Inbox and Saved Voice Mail
Playing Messages
You can play voice mail messages through your phone or on the PC using the Web 
Portal.

1. Click on the Voice Mail tab, and select the Inbox or Saved tab 

2. Find the message you want to play.

3. You can play the message two ways:

• Click the Voice Mail ( ) button to listen to the message on your PC 
speaker. 

• Click the  button listen to the message on your phone

The Call Control Window will appear and the message will play. You can stop 
listening to the message at any time by clicking Release in the Call Control 
Window or you can wait for the message to end.

4. When the message finishes playing, the voice mail system hangs up.

NOTE: If you click Voice Mail button too soon after pulling up the Inbox page, 
you may get a dialog saying that the ActiveX component is not yet loaded. If 
this happens, simply wait a few more seconds before clicking on the button 
again. When this page first appears, there will be a small grey box under the 
Directory menu. When that box disappears, the ActiveX component is 
loaded.

Returning Calls from the Call Log
1. Locate the entry/message to which you want to return a call.

2. Click on the extension or telephone number of that entry/message in the 
Phone Number column.

3. The Call Control window appears and displays call progress messages while 
you hear ringing through the speaker in your phone.

4. To end the call you can click on:

• Release to hang up
• Transfer to transfer the call
• Hold to put the call on hold
• Park to park the call

You must have the features listed in Step 4 assigned to your phone for those 
features to be available from the Web Portal.
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Save or Delete Voice Mail
Save or Delete Voice Mail
Voice mail can be saved or deleted from the Inbox and deleted from the Saved 
Voice Mail. Voice mail remains in the Inbox until saved or deleted and remains in 
Saved Voice Mail until deleted. Listening to voice mail does not cause it to be saved 
or deleted.

Saving voice mail (from the Inbox)

1. Find the voice mail message you want to save.

2. Click the Select checkbox at the end of the message so it is checked.

3. Repeat for as many messages as you want to save.

4. Click Move to Saved at the bottom of the message list.

The messages should be removed from the Inbox message list. If you select the 
Saved tab, you should see the saved messages in the message list.

Deleting voice mail

1. Find the voice mail message you want to save.

2. Click the Select checkbox at the end of the message so it is checked.

3. Repeat for as many messages as you want to delete.

4. Click Delete at the bottom of the message list.

The messages should be removed from the message list.

Forwarding Messages
You can forward voice mail messages under control of the Web Portal by creating 
a list of persons with voice mail mailboxes to receive the forwarded message.

1. Click on the Voice Mail tab and then either the Inbox or Saved tab. Find the 
message you want to forward.

2. Click the Forward button ( ) in the Functions column.

3. On the next page, choose who you want to forward the message to:

• click the Add Extensions button to select an individual to forward the 
message to. To select one or more extensions, click the Select checkbox 
and click Save. 

• click the Add Distribution Groups button to select a Voice Mail 
Distribution Group that you want to receive the message. Click the Select 
checkbox next to the desired group(s) and click Save. 
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Managing Voice Mail Distribution Groups

 

4. On the Forwarding screen, click the Select checkboxes for all of the 
destinations where you want to send the voice mail.

NOTE: To remove a name from the list, click the Select checkbox next to the 
entry, and click Delete. 

5. Click Forward to send the voice mail.

Managing Voice Mail Distribution Groups
Voice mail distribution groups allow you to send or forward messages to multiple 
users using a group name. You may have up to 20 personal distribution groups. 
You may also see company-wide distribution lists. These lists are available for your 
use, but you cannot edit them.

This screen allows you to:

• Add a distribution group
• Edit an exisiting group
• Delete a group

You can click on the column heading to sort the groups by Name or Number. The 
column used for sorting is noted by a star next to the column heading. The order of 
the columns is not changed when they are sorted.

ID numbers 80-99 are assigned to the groups by the PressOne system and cannot be
changed. You can name the group when it is created and change it at any time 
using the edit feature.

When you create a group for the first time, the Name field will contain the default 
name "New Group" and there will be no members listed for the group. Once you 
save the new group, it will then appear in the Voice Mail Lookup list as a valid voice 
mail target.

Create a New Voice Mail Distribution Group
1. Click on the Voice Mail tab, then select Dist. Groups. Click Add.

2. Click the Add Members button.

3. Click the Select checkbox next to each entry in the listing that you want to 
add to the Distribution Group.

NOTE: You can search for users by clicking on the alphabet at the top of the 
Voice Mail Lookup window.

4. By default, the new distribution group will be named "Dist Group NN" where 
NN is a sequential number. To give the group a more specific name, click 
Change Distribution Group Name. 

5. Click Save.
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Editing an Existing Voice Mail Distribution Group
6. Click the Voice Mail tab to return to the Distribution Groups main screen.

Editing an Existing Voice Mail Distribution Group
You can modify the members of a distribution group and the group's name using 
the Web Portal. To edit a distribution group, click the Voice Mail tab and Dist. 
Groups tab, then following the instructions below. 

Changing the Name of the Distribution Group

1. Click the Edit button ( ) next to the entry in the group list that you want to 
modify.

2. Click the Change Distribution Group Name button.

3. Enter a new name for the distribution group, and click Save. 

4. Click the Voice Mail tab again to return to the Distribution Group listing.

Adding Members

1. Click the Edit button ( ) next to the entry in the group list that you want to 
modify.

2. Click the Add Members button.

3. Enter a new name for the distribution group, and click Save. 

4. For each extension you want to add, click the Select checkbox so that it is 
checked.

5. Click Save.

6. Click the Voice Mail tab again to return to the Distribution Group listing..

Deleting Members

1. Click the Edit button ( ) next to the group that you want to modify.

2. For each member you want to delete, click the Select checkbox so that it is 
checked.

3. Click Save.

4. Click the Voice Mail tab again to return to the Distribution Group listing.

Delete a Distribution Group
1. Click on the Voice Mail tab, then select the Dist. Groups tab. 

2. For each group you want to delete, click the Select checkbox so that it is 
checked.

3. Click Delete.
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Setting Voice Mail Paging Notification
Sorting Messages
The list can be sorted in ascending (top-down.) order or descending order based 
on any of the columns that has an underlined title. Click a column heading to sort 
the list based on that column.

The column that is currently being used for sorting is marked with an up- or down-
arrow. If the arrow is pointing down, then the list is sorted in ascending order (top-
down, first to last, A-Z, etc.). If the arrow is pointing up, then the list is sorted in 
descending order based on that column.

If the information displayed does not seem to be up-to-date, see Web Browser 
Settings.

Setting Voice Mail Paging Notification
The VOISS system provides the ability for you to be alerted on your mobile phone 
or pager that you have received a voice mail message. 

1. Click on the Voice Mail tab and select the Paging tab.

2. From the Notification for pull-down menu, select the type of calls you want 
to be notified of (Urgent Calls or All Calls). Select None to disable paging.

3. Click on the Pager Type pull-down list and select the type of pager (Numeric, 
Voice Call or E-Mail).

4. In the Pager Number field, enter the phone number for a numeric or voice 
pager or the e-mail address for an e-mail page in the following format:

• For numeric or voice call paging use: 0-9, #, *, - spaces, parenthesis, 
commas (ex. 1-800-555-5555, 1762, (972)354-5555)

• For e-mail, use valid E-mail addresses (ex. mybestfriend@sprint.com.)

5. In the Pager Message field, enter text information that you want to be sent to 
a numeric or e-mail pager.

Remember that mobile devices support different types of alerts:

• Basic numeric pages accept only keypad phone digits (1-0, * and #).
• Some cell phones support voice streaming.
• Some cell phone models can receive text-only e-mails.
• E-mail pagers accept text-only e-mail messages.

What You Receive with Paging Notification
Numeric - You receive the information you entered in the Pager Message field 
when you set up the pager option. The information could be the phone number of 
the voice mail system or a code that means something to you.
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What You Receive with Paging Notification
Voice - When you answer the page, voice mail plays a welcome announcement 
followed by a request for your voice mail account password. Enter your password 
and listen to the normal voice mail menu options. If the voice message is marked 
as "Urgent", the first voice message you receive is the urgent message. When 
someone leaves a voice mail message on your phone, the system immediately 
dials your pager or cellular phone. The system tries to reach you every five 
minutes, up to three times if you don’t answer. If you take the call, but you don’t 
enter digits at the prompt, the system acts like you never answered the call and 
continues trying to reach you as stated above. If you have caller id, your “office” 
phone number/name is displayed as the caller.

E-Mail -The message you receive reads as follows:

• Subject: Voice Mail from <calling party>
• Body: the text you enter (for example, Important voice mail, check 

immediately.)

If you leave the body empty, you get the following:

<calling party> called you on <date> at <time>.

• calling party = name, if known, and telephone number
• date = system date
• time = system time

Changing the Voice Mail Password
You may wish to change the voice mail password from either

• the default provided by your system administrator to give you initial 
access to the system; or

• from a password that has been compromised (someone figured it out, you 
had to tell someone so they could retrieve information for you, etc.)

To change the password:

1. Enter the old password in the Current Password text box.

2. Enter the new password in the New Password text box.

3. Enter the new password in the Confirm Password text box.

4. Click Submit.
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Changing the Voice Mail Password
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Chapter 7
Using the Web Portal Options

The Web Portal Options menu provides functions for the Web Portal application 
as well as provides some configuration functions for the PressOne phone.

• Change Password – Allows you to change the password for your PressOne
telephone and for the Web Portal.

• Remote Phone – Allows you to set up a remote phone to act as if it were 
the VOISS phone. Instead of placing and receiving calls from the PressOne
phone, calls are made and answered from the Remote Phone. The 
CallerID presented on outgoing calls and the features available to the 
user while connected remotely make it appear to all concerned like the 
user is calling from the PressOne phone.

• Reassign Phone – Allows you to to reassign your phone number to a 
different physical phone. You can also unassign the phone number and 
place the phone in "out of service" mode.

• Modify your Profile – Allows you to configure specific features of the Web 
Portal.

• PC Integration – Allows you to download and run the PressOne TAPI 
application that allows TAPI-enabled programs, such as Microsoft Office, 
to dial through the PressOne system.

Remote Phone
NOTE: The Remote tab appears under the Options tab only if the user has 
a Remote Phone button on their phone set up by the System Administrator.

The Remote Phone feature provides the capability to set up a remote phone to act 
as if it were the PressOne phone. Instead of placing and receiving calls from the 
PressOne phone, calls are made and answered from the Remote Phone.

WARNING: You cannot dial 911 from the Remote Phone while connected 
to the PressOne system. An attempt to dial 911 will produced a message telling
you to hang up the phone first (which disconnects the Remote Phone 
feature), then dial 911. 

Your Caller ID on outgoing calls and the features available to you while connected 
remotely make it appear to all concerned like you are calling from your PressOne 
phone. For example, you could configure your cell phone to be your remote phone, 
and it would appear to be your PressOne phone. All calls coming into your PressOn
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Changing the Web Portal Password

, 

 

(office) phone would ring your cell phone instead. All calls placed from the remote 
phone will look on the receiver's caller ID as if they are being placed from your
PressOne phone.

NOTE: The Web Portal will only show the Remote Phone enabled status if 
the remote phone was activated from the Web Portal. If the remote phone 
was enabled by dialing into the PressOnesystem from the remote phone, the 
active status will not be shown on the Web Portal display.

You can disconnect from an outgoing or incoming call by pressing "###". However, 
if you simply hang up the remote phone, then the remote status is disabled and the 
remote phone is no longer connected to the PressOne system.

To set up a Remote Phone:

1. From the Options menu, select Remote Status.

2. Click the Enable Remote User checkbox to activate the Remote Phone. 

3. If desired, click the Enable Remote Caller ID checkbox to show the caller ID 
of the incoming call. 

4. Enter a Remote Phone Number to be used as the Remote Phone. 

NOTE: Be sure that the phone number you enter is a valid phone number. 

5. If desired, select a number of seconds to Ring the Remote Phone from the 
pull down list.

6. Click Save.

7. Go to a Phone Directory and make an outgoing phone call. This will cause 
the PressOne system to call the remote phone number and, when it is answered
it will configure that phone as the remote phone. Then it will place the 
outgoing phone call from the remote phone. 

NOTE: If the remote phone is not answered in 30 seconds, then the PressOne
system will disconnect and the remote phone will not be set up. 

Changing the Web Portal Password
You may wish to change the Web Portal password from either

• the default provided by your system administrator to give you initial 
access to the system; or

• from a password that has been compromised (someone figured it out, you 
had to tell someone so they could retrieve information for you, etc.)

To change the password:

1. Enter the new password in the Password text box.

2. Enter the new password in the Confirm Password text box.
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3. Click Submit.

If the information displayed does not seem to be up-to-date, see Web Browser 
Settings.

Reassign Phone
This page of the Web Portal allows the user to reassign their phone number to 
another physical phone. For example, if you will be working in a different office, you 
may want your extension to ring in that office instead the usual location. 

Requirements
The following conditions are required before you can successfully reassign a 
phone extension:

• The new phone must be the same type of phone that the number was 
originally assigned to.

• The new phone must be "out of service", meaning that it currently does 
not have a number assigned to it. If the phone already has a number 
assigned to it, you can unassign the phone using one of the following 
methods:
• Log into that phone from the Web Portal, click on the Options menu, 

select the Reassign tab, and erase the MAC address shown. Click on 
the Save button. A dialog will ask if you want to unassign the phone. 
Click OK to unassign the phone, or Cancel to exit without changing it.

• On the phone itself, enter the Internal Access Code (default 588) to 
enter the phone configurator. Follow the prompts to unassign the 
phone.

To Reassign the Phone
WARNING: Be sure the phone to be reassigned is not being used for an 
active call. The phone can be reassigned while in an active call.

1. Click the Reassign tab on the Options page. On the new phone, locate the 
12-digit MAC address, usually found on a sticker on the underside of the 
phone.

2. Enter the MAC address in the MAC Address field and click the Save button.

Modifying Your Profile Settings
When you click on Options, then Profile, you can modify several configuration 
settings for your phone. 

Home Page – You can choose which page the Web Portal displays on startup. 
VOISS Web Portal User’s Guide Using the Web Portal Options 47
621-000000096



PC Integration
Rows Per Page – Choose how many rows you wish to display per page.

Seconds Before Voice Mail – Specify how many seconds your phone should ring 
unanswered before it is transferred to your voice mail box.

If you modify any of these settings, click the Submit button to make them take 
effect.

PC Integration
The PC Integration tab (from the Options tab) allows you to download the VOISS 
TAPI (Telephony Application Program Interface) Service Provider application. TAPI 
is a standard program interface that lets you and your computer "talk" over 
telephones or video phones to people or phone-connected resources elsewhere in 
the world. TAPI integration allows TAPI-enabled programs, such as Microsoft 
Office, to dial through the VOISS system. 

NOTE: The PC Integration tab is visible only if the system administrator has 
configured your phone to be TAPI-enabled.

To set up TAPI on your PC:

1. Click the Options tab.

2. Click the PC Integration tab.

3. Click Install VOISS TAPI Service Provider to begin the installation process.

4. On the dialog box that pops up, select a method for the installation and click 
OK. We recommend you select the Save this program to disk option so that 
the install is available if needed again.

NOTE: The IP address shown in the location notice will be the IP address of 
the web server the Web Portal is connected to.

5. Choose where to save the TAPI.EXE file and click Save. 

6. On your PC, find the TAPI.EXE file and double-click it to run the installation 
procedure.

7. Follow the instructions provided to install the software. 

NOTE: Before you can dial from the TAPI-enabled program, you must 
configure Windows for TAPI configure Windows for TAPI and configure 
Outlook (or other dialing program) configure Outlook (or other dialing 
program) to use the VOISS telephone line.
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